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บทที่ 4 

พื้นฐานการสร้างภาพเคลื่อนไหวโดยใช้คอมพิวเตอร์ 
  

 เทคโนโลยีคอมพิวเตอรท์ี่ใช้ในการสร้างภาพเคลื่อนไหวไดร้ับการพัฒนาอย่างต่อเนื่อง ใน

ปัจจุบันบริษัทออกแบบโฆษณาและสตูดิโอต่างๆ มีความต้องการนักออกแบบที่มีความเข้าใจใน

กระบวนการสร้างภาพเคลื่อนไหวและมีทักษะเบื้องต้นทางด้านการใช้โปรแกรมสำหรับการสร้างภาพ

เคลื่อนไหว กรรมวิธีในการสร้างภาพเคลื่อนไหวนั้นมีหลายวิธีการ เช่น การสร้างภาพเคลื่อนไหวแบบ

ดั่งเดมิ (Traditional Animation) ซึ่งเปน็การวาดภาพนิ่งทลีะเฟรม โดยจะตอ้งทำการวาดภาพนิ่ง

จำนวนมากมายเพื่อให้ได้ภาพเคลื่อนไหวไม่กี่นาที การสร้างภาพเคลื่อนไหวแบบสต๊อปโมชัน (Stop 

Motion) ซึ่งเป็นการภาพถ่ายของหุ่นนิ่งที่อาจทำจากระดาษ ดิน หรือหุ่นโมเดลโดยค่อยๆ ขยับหุ่น

และถ่ายภาพทีละภาพ ต้องใช้ต้นทุนและความอดทนในการผลิตสูงเนื่องจากเป็นงานที่ต้องอาศัย

ความละเอียดประณีตมาก อีกวิธีการหนึ่งในการสร้างภาพเคลื่อนไหวคือการสร้างภาพเคลื่อนไหว

โดยใช้คอมพิวเตอร์ (Computer Animation) ในปัจจุบันมีโปรแกรมสำเร็จรูปที่ใช้ในการสร้างภาพ

เคลื่อนไหวเกิดขึ้นหลายโปรแกรม แต่ละโปรแกรมมีคุณสมบัติที่แตกต่างกันตามวัตถุประสงค์ของ

การผลิตผลงาน การใช้คอมพิวเตอร์ในการสร้างผลงานนั้นช่วยลดความยุ่งยากซับซ้อน ช่วยประหยัด

เวลาและต้นทุนในการผลิต หากแต่ผู้ที่สร้างสรรค์ผลงานนั้นจะต้องมีความเข้าใจในหลักการและ

จำเป็นต้องอาศัยการฝึกฝนให้เกิดทักษะความชำนาญเพื่อสามารถถ่ายทอดความคิดจินตนาการออก

มาเป็นผลงานภาพเคลื่อนไหว 

โปรแกรมสำเร็จรูปที่ใช้ในการสร้างภาพเคลื่อนไหว 

  

 โปรแกรมที่ใช้สร้างภาพเคลื่อนไหวในปัจจุบันนั้นมีมากมายและมีคุณสมบัติของโปรแกรมที่

แตกต่างกัน ในบางโปรแกรมสามารถสร้างงานที่ซับซ้อนสมจริงในรูปแบบสามมิติได้และในบาง

โปรแกรมสามารถสร้างผลงานที่มีความน่าสนใจในรูปแบบสองมิติ ในการเลือกใช้งานแต่ละโปรแกรม

นั้นจะต้องขึ้นอยู่กับโจทย์และวัตถุประสงค์ของงานออกแบบ อีกทั้งยังต้องคำนึงถึงระยะเวลาและ

ต้นทุนในการผลิตผลงานอีกด้วย โปรแกรมต่างๆ ที่ใช้ในการสร้างภาพเคลื่อนไหว ได้แก่ 

 1) โปรแกรมสามดีเอสแมกซ์ (3ds Max) เป็นโปรแกรมสำเร็จรูปเพื่อสร้างงานกราฟิก

แบบสามมิติและงานออกแบบภาพเคลื่อนไหวระดับสูง ดังที่ จง บุญประชา (2548, น.1-2) กล่าวถึง

ไว้ สรุปได้ว่า โปรแกรมสามดีเอส แมกซ์ เป็นโปรแกรมที่มีการทำงานที่ซับซ้อนในลักษณะสามมิติ

เป็นหลัก ดังนั้นจึงมีหลักการการทำงานบนพื้นฐานของแกน X (แนวนอน) แกน Y (แนวตั้ง) และ



 132

แกน Z (แนวลึก) ร่วมถึงการทำงานร่วมกันกับลักษณะพิเศษปลั๊กอิน (Plug-in) เพื่อให้ได้ภาพที่

สมจริง นอกจากจะสามารถทำภาพเคลื่อนไหวได้แล้วยังนิยมใช้ในการขึ้นรูปโมเดล งานออกแบบ

ผลิตภัณฑ์ และงานสถาปตัยกรรมอกีด้ วย ผู้ที่ใชง้านโปรแกรมนี้จำเปน็ตอ้งอาศยัอปุกรณฮ์ารด์แวรท์ี่มี

คณุภาพสงู อีกทั้งยังต้องใช้ทักษะความชำนาญในการใช้โปรแกรมอย่างมาก เนื่องจากการสร้างงาน

ด้วยโปรแกรมนี้มีความซับซ้อนมาก 

  

ภาพที่ 4.1 งานออกแบบตัวละครเคลื่อนไหวโดยใช้ โปรแกรมสามดีเอส แมกซ์ 
(Character Animation and Rigging Tools) 

ที่มา: Autodesk (2015) 

 2) โปรแกรมมายา (Maya) เป็นโปรแกรมสำเร็จรูปเพื่อสร้างงานกราฟิกแบบสามมิติและ

งานออกแบบภาพเคลื่อนไหวระดับสูง ถูกพัฒนาขึ้นเพื่อวงการบันเทิงด้วยการใช้งานที่มีความ

ยืดหยุ่นสูง มีความสามารถอย่างมากในการสร้างสรรค์ตัวละครและมีเทคนิคพิเศษสำหรับงาน

ภาพยนตร์ โปรแกรมมายาสามารถโต้ตอบกับผู้ใช้ได้อย่างคล่องตัว ช่วยสร้างภาพเคลื่อนไหวที่

เสมือนจริงมากที่สุด นิยมใช้มากในการสร้างเกม การสร้างภาพยนตร์การ์ตูน เนื่องจากตัวละครที่

สร้างจากโปรแกรมนี้จะมีความยืดหยุ่นสามารถปรับแต่งได้อย่างอิสระอีกทั้งยังสามารถใส่ลักษณะ

พิเศษ (Effect) ลงในภาพยนตร์ได้ ทางด้านการพัฒนาเกม ในปัจจุบันเกมส่วนใหญ่ได้รับการพัฒนา

ให้เป็นเกมในรูปแบบสามมิติแทบทั้งสิ้น เนื่องจากทำให้ผู้เล่นสามารถเข้าถึงอารมณ์และบรรยากาศที่

เสมือนจริง การสร้างภาพเคลื่อนไหวโดยใช้โปรแกรมนี้จะต้องอาศัยอุปกรณ์ฮาร์ดแวร์ที่มีคุณภาพ

มาก ตัวโปรแกรมมีราคาสูงและผู้ใช้งานจะต้องมีทักษะขั้นสูงและจะต้องฝึกฝนการใช้โปรแกรมอย่าง

หนักจนมีความชำนาญจึงจะสามารถสร้างภาพเคลื่อนไหวได้อย่างมีคุณภาพ (AutoDesk Maya 

โปรแกรมทำแอนิเมชั่น 3D ชั้นสูง ที่หนังแอนิเมชั่นต่างๆ นิยมใช้สร้างกัน (“Maya (โปรแกรม Maya 

ทำอนิเมชั่น สร้างการ์ตูน Animation),” 2558) 
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ภาพที่ 4.2 งานออกแบบตัวละครเคลื่อนไหวโดยใช้โปรแกรมมายา 
(Clump Modifier for Interactive Grooming) 

ที่มา: Autodesk (2015) 

 3) โปรแกรมไลท์เวฟสามดี (Lightwave 3D)  เป็นโปรแกรมสำเร็จรูปเพื่อสร้างงาน
กราฟิกแบบสามมิติและงานออกแบบภาพเคลื่อนไหวระดับสูง เป็นโปรแกรมที่สตูดิโอส่วนใหญ่นิยม
นำมาใช้ในการสร้างภาพเคลื่อนไหวสามมิติ สามารถสร้างหุ่นโมเดลได้ง่ายและรวดเร็ว อีกทั้งยังมีการ
ประมวลผลที่สามารถเรนเดอร์ (Render) ภาพได้สมจริง สร้างผลงานได้อย่างหลากหลาย ไม่ว่าจะ
เป็นวิธีการในการสร้างรูปทรง การวางมุมกล้อง การสร้างภาพเคลื่อนไหว การใส่พื้นผิว การจัด
สภาพแสงรวมทั้งการจัดสภาพแวดล้อมให้กับชิ้นงาน การสร้างภาพเคลื่อนไหวโดยใช้โปรแกรมนี้จะ
ต้องใช้อุปกรณ์ฮาร์ดแวร์ที่มีคุณภาพสูงและผู้ใช้งานต้องมีพื้นฐานในการสร้างงานสามมิติอย่าง
ชำนาญ  

  

ภาพที่ 4.3 งานออกแบบตัวละครเคลื่อนไหวโดยใช้โปรแกรมไลท์เวฟสามดี 
(Genoma 2 allows you to create expert rigs for character animation) 

ที่มา: Lightwave3d (2015) 
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 4) โปรแกรมแฟลช (Flash) เป็นโปรแกรมสำเร็จรูปเพื่อสร้างงานกราฟิกแบบสองมิติ งาน

สื่อมัลติมีเดียและงานออกแบบภาพเคลื่อนไหวระดับสูงที่สามารถโต้ตอบได้ รองรับทั้งภาพกราฟิก

แบบเวกเตอร์ (Vector) และภาพกราฟิกแบบบิตแมท (Bitmap) และมีภาษาสคริปต์ที่เอาไว้ใช้เขียน

โดยเฉพาะเรียกว่าแอ็คชันสคริปต์ (ActionScript) สามารถทำงานในลักษณะ CGI  โดยเชื่อมต่อกับ

การเขียนโปรแกรมภาษาอื่นๆ ได้มากมาย ได้แก่ ภาษา PHP ภาษา C ภาษา JAVA ภาษา VB 

เป็นต้น คุณสมบัติสำคัญของโปรแกรมแฟลชคือความสามารถในการบีบอัดไฟล์ให้มีขนาดเล็ก  มีผล

ทำให้การแสดงผลเป็นไปด้วยความรวดเร็ว นอกจากนั้นยังสามารถแปลงไฟล์ได้หลายสกุล ได้แก่ 

สกุล avi สกุล mov สกุล gif สกุล wav สกุล jpg สกุล gif ป็นต้น นิยมใช้โปรแกรมนี้ในการสร้าง

ภาพเคลื่อนไหวแบบสองมิติ การออกแบบเกม การออกแบบอินเตอร์แอ็คทีฟในเว็บเพจทำให้การนำ

เสนอทำได้อย่างน่าสนใจ นอกจากนั้นยังสามารถสร้างแอพพลิเคชั่น (Application) เพื่อใช้ทำงาน

ต่างๆ รองรับการใช้งานกับอุปกรณ์ที่เชื่อมต่อกับระบบเครือข่ายอินเตอร์เน็ต และทำงานได้กับหลาย

แฟลตฟอร์ม (Platform) แต่เนื่องจากการทำงานในโปรแกรมนี้มีความยุ่งยากซับซ้อนจึงไม่เป็นที่

นิยมใช้งานอีก อีกทั้งบริษัทอะโดบีได้หยุดพัฒนาโปรแกรมนี้และพัฒนาโปรแกรมอื่นขึ้นมาแทนที่เพื่อ

การใช้งานที่มีคุณภาพมากขึ้นและมีการตอบสนองวัตถุประสงค์ในการออกแบบที่ชัดเจนมากขึ้น 

(สิทธิชัย ทิพย์สิงห์, ม.ป.ป.) 

  

ภาพที่ 4.4 งานออกแบบตัวละครเคลื่อนไหวโดยใช้โปรแกรมแฟลช 
(Flash-the most common animation program for the internet) 

ที่มา: EB Design (2015) 

 5) โปรแกรมอนิเมท (Animate) เป็นโปรแกรมสำเร็จรูปซึ่งบริษัทอะโดบีได้รับการพัฒนา

ขึ้นโดยมีคุณสมบัติหลักคือการสร้างภาพเคลื่อนไหวในรูปแบบสองมิติ รวมไปถึงพัฒนาเครื่องมือและ

คำสั่งในการวาดรูปที่หลากหลายและดีขึ้น ผลงานรองรับการนำเสนองานทางสื่อออนไลน์โดยตรง 

https://th.wikipedia.org/w/index.php?title=%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%AA%E0%B8%84%E0%B8%A3%E0%B8%B4%E0%B8%9B%E0%B8%95%E0%B9%8C&action=edit&redlink=1
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ช่วยให้การทำงานกับภาพของนักออกแบบง่ายขึ้นด้วยการทำงานร่วมกับอะโดบี สต็อก (Adobe 

Stock) และอะโดบี ครีเอทีฟ คลาวด์ ไลบรารี่ (Adobe Creative Cloud Libraries) อีกทั้งยัง

รองรับการทำงานของไฟล์ซึ่งสร้างจากโปรแกรมแฟลต (กฤษณ์ ปรัชญาาทิน, 2558) โปรแกรมนี้เป็น

โปรแกรมซึ่งได้รับการพัฒนาขึ้นใหม่ มีผู้ใช้งานเป็นกลุ่มเฉพาะโดยยังไม่ได้รับความนิยมมากนัก 

  

ภาพที่ 4.5 งานออกแบบภาพเคลื่อนไหวโดยใช้โปรแกรมอนิเมท 
(Animate just about anything) 

ที่มา: Adobe (2016) 

 6) โปรแกรมอาฟเตอรเ์อฟเฟกต ์ (After Effect) เปน็โปรแกรมสำเรจ็รปูเพื่อสรา้งภาพ

เคลื่อนไหวและสรา้งงานวดิโีอ ดงัที่อศิเรศ ภาชนะกาญจน ์(2559, น.2) กลา่วถงึไว ้สรปุไดว้า่โปรแกรม

อาฟเตอร์เอฟเฟกต์เป็นโปรแกรมที่สามารถออกแบบโมชันกราฟิก (Motion Graphic) และสามารถ

สร้างวิชชวลเอฟเฟกซ์ (Visual Effect) ในภาพยนตร์โดยเฉพาะ โปรแกรมนี้ถูกพัฒนาให้มีการ

ทำงานที่ตอบสนองความต้องการที่หลากหลายของนักออกแบบ มีเครื่องมือที่สามารถทำงานได้กับ

ทั้งภาพนิ่ง ไฟล์วิดีโอ ไฟล์เสียง รองรับทั้งภาพกราฟิกแบบเวกเตอร์ (Vector) และภาพกราฟิกแบบ

บิตแมท (Bitmap) สามารถทำงานได้ทั้งรูปแบบสองมิติและสามมิติ  ทำให้โปรแกรมนี้เป็นที่ยอมรับ 

และถูกนำไปใช้ในงานโทรทัศน์ งานภาพยนตร์ งานออกแบบโฆษณา ซึ่งบริษัทออกแบบโฆษณาและ

สตูดิโอต่างๆ นิยมใช้โปรแกรมนี้ในการสร้างภาพเคลื่อนไหวเนื่องจากสามารถตอบสนองงาน

ออกแบบได้หลากหลาย 
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ภาพที่ 4.6 งานออกแบบภาพเคลื่อนไหวโดยใช้โปรแกรมอาฟเตอร์เอฟเฟกต์ 
(Character Animation Frustrations for After Effects users) 

ที่มา: Yaron Sass (2016) 

 จากข้อมูลเบื้องต้นจะเห็นว่าโปรแกรมสำเร็จรูปที่ใช้ในการสร้างภาพเคลื่อนไหวนั้น  มีหลาย

โปรแกรมสามารถเลือกใช้งานได้ตามวัตถุประสงค์ในการออกแบบ แต่ละโปรแกรมมีคุณสมบัติและ

จุดเด่นที่แตกต่างกัน อาทิ โปรแกรมสามดีเอสแมกซ์ โปรแกรมมายา และโปรแกรมไลท์เวฟสามดี 

เหมาะกับการสร้างงานภาพกราฟิกแบบสามมิติและงานออกแบบภาพเคลื่อนไหวระดับสูง จำเป็น

ต้องอาศัยอุปกรณ์ฮาร์ดแวร์ที่มีคุณภาพสูงมาก และผู้สร้างผลงานจะต้องมีความเชี่ยวชาญขั้นสูงจึง

จะสามารถสร้างภาพเคลื่อนไหวได้อย่างมีคุณภาพ โปรแกรมแฟลชเหมาะกับการสร้างภาพ

เคลื่อนไหวแบบสองมิติ งานออกแบบสื่อมัลติมีเดีย งานออกแบบอินเตอร์เฟส แต่ในปัจจุบันความ

นิยมในการใช้โปรแกรมนี้ลดลงและโปรแกรมไม่ได้รับการพัฒนาอีก โปรแกรมอนิเมทเป็นโปรแกรมที่

มีคุณสมบัติในการสร้างภาพเคลื่อนไหวที่ตอบสนองงานบนสื่อออนไลน์เป็นสำคัญ อีกหนึ่งโปรแกรม

ที่ได้รับความนิยมในการใช้งานกันอย่างแพร่หลายคือโปรแกรมอาฟเตอร์เอฟเฟกต์ สามารถรองรับ

การทำงานทั้งรูปแบบสองมิติและสามมิติ มีคุณสมบัติที่มีการทำงานที่ตอบสนองความต้องการของ

นักออกแบบได้หลากหลายและมีประสิทธิภาพมาก 

การสร้างภาพเคลื่อนไหวด้วยโปรแกรมอาฟเตอร์เอฟเฟกต์ 

 โปรแกรมอาฟเตอรเ์อฟเฟกตเ์ปน็โปรแกรมที่เหมาะกบังานสรา้งภาพเคลื่อนไหว งานออกแบบ

โมชั่นกราฟิก งานตกแต่งวิชชวลเอฟเฟกต์สำหรับงานวิดีโอและงานภาพยนตร์ มีการทำงานที่       

ตอบสนองความตอ้งการที่หลากหลายของนกัออกแบบ และมคีณุสมบตักิารทำงานที่สนบัสนนุทั้งไฟล์

ภาพนิ่ง ไฟลว์ดิโีอ และไฟลเ์สยีง อกีทั้งยงัรองรบัการทำงานทั้งรปูแบบสองมติแิละสามมติ ิ 
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 1. คุณสมบัติของโปรแกรมอาฟเตอร์เอฟเฟกต์  

 โปรแกรมอาฟเตอร์เอฟเฟกต์เป็นโปรแกรมที่ถูกพัฒนาให้สนับสนุนการสร้างภาพเคลื่อนไหว 

งานตกแต่งวิชชวลเอฟเฟกต์สำหรับงานวิดีโอและภาพยนตร์ มีเครื่องมือและคำสั่งการทำงานที่

อำนวยความสะดวกให้ผู้ใช้งาน สามารถรองรับระบบเสียง ระบบภาพ ไฟล์งานต่างๆ จากโปรแกรม

ทั้งสองมติแิละสามมติ ิดงัที่จฑุามาศ จวิะสงัข ์(2558, น.2-5) อธบิายคณุสมบตัขิองโปรแกรมอาฟเตอร์

เอฟเฟกตไ์ว ้สามารถสรปุไดด้งันี้ 

 1)  มีการทำงานรองรับทั้งระบบภาพและเสียง โปรแกรมรองรับรูปแบบไฟล์ที่หลาก

หลายทั้งระบบภาพและระบบเสียงทุกระบบจากโปรแกรมทั้งสองมิติและสามมิต ิ เพื่อให้ตอบสนอง

การสรา้งภาพเคลื่อนไหว การตกแตง่ตดัตอ่ และการเพิ่มเตมิลกัษณะพเิศษ (Effect) มากที่สดุ ทำให้

การทำงานง่ายขึ้นและปราศจากข้อจำกัดในการนำไฟล์งานมาใช้ 

 2)  มีการทำงานรองรับองค์ประกอบต่างๆ ได้ทั้งรูปแบบสองมิติและสามมิติ 

สามารถใช้เครื่องมือและคำสั่งต่างๆ ในการแก้ไขหรือสร้างลักษณะพิเศษผ่านการวาด การสร้างสรรค์

เทคนิคตกแต่งต่างๆ การรองรับการจัดแสงและกล้องที่ทำให้ภาพมีมิติ รวมทั้งสามารถนำกล้องที่ถูก

ตั้งค่าไว้แล้วในโปรแกรมสามมิติเข้ามาใช้งานได้ นอกจากนั้นยังรอบรับค่าแสงที่หลากหลาย สามารถ

ปรับแต่งเพิ่มเติมโดยการเลือกรูปแบบแสงต่างๆ เพื่อให้สอดคล้องกับฉากได้ 

 3)  มีความสามารถในการปรับแต่งสีสันให้กับวิดีโอ โปรแกรมมีเครื่องมือในการ

ตกแตง่สสีนัใหก้บัไฟลง์าน อาท ิ ยอ้มสภีาพใหด้เูกา่ หรอืยอ้มสภีาพใหส้ดใสขึ้น ซึ่งทำใหง้านดนูา่สนใจ

แปลกตายิ่งขึ้น 

 4) มีความสามารถในการสร้างตัวอักษรและการวาดภาพกราฟิกแบบเคลื่อนไหว   

โปรแกรมมีชุดคำสั่งในการสร้างการเคลื่อนไหวให้กับตัวอักษรตามรูปแบบที่โปรแกรมมีให้และยัง

สามารถตกแต่งการเคลื่อนไหวได้อย่างอิสระตามที่นักออกแบบต้องการ นอกจากนี้ยังมีเครื่องมือที่ใช้

ในการสร้างภาพในรูปแบบเวคเตอร์และสามารถควบคุมให้เกิดการเคลื่อนไหวได้ตามต้องการ 

 5) มีความสามารถในการตกแต่งลักษณะพิเศษ (Special Effects) ได้หลากหลาย

รูปแบบ โปรแกรมมีชุดคำสั่งในการตกแต่งลักษณะพิเศษที่หลากหลาย ทั้งการปรับเปลี่ยนการแสดง

ผลภาพ การสร้างฉากกรีนสกรีน รูปแบบการเคลื่อนไหวลักษณะต่างๆ อีกทั้งยังสามารถเพิ่มปลั๊กอิน 

(Plug-in) ลักษณะพิเศษที่เสริมเข้ามาช่วยตกแต่งชิ้นงานได้อีกด้วย 

 6)  มีความสามารถในการสร้างภาพเคลื่อนไหว โปรแกรมมีเครื่องมือและชุดคำสั่งใน

การควบคุมชิ้นงานให้เหมือนการควบคุมหุ่นกระบอก สามารถจัดการเคลื่อนไหวได้อย่างอิสระ 

นอกจากนี้ยังมีเครื่องมือเกี่ยวกับกล้องที่มีคุณภาพและสามารถควบคุมการทำงานของกล้องได้ง่าย 

 7) มเีครื่องมอืแบบ AI ที่ตอบสนองความตอ้งการในการทำงาน โปรแกรมมเีครื่องมอืที่

พร้อมจะตอบสนองความต้องการในการสร้างสรรค์ ช่วยให้ทำงานสะดวกมากขึ้นอาทิเครื่องมือโรโท
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บรัช (Roto Brush) ที่สามารถแยกวัตถุหลักออกจากฉาก (Isolated Object) ได้โดยใช้เมาส์ลาก

ผ่านวัตถุที่ต้องการแยกออก โปรแกรมก็จะคำนวณและทำการแยกวัตถุในฉาก การกำหนดพื้นที่ที่

ต้องการและการซ่อนภาพโดยการทำแทร็กแมตต์ (Track Mattes) และยังมีเครื่องมืออื่นๆ ที่ช่วยให้

ทำงานได้เร็วขึ้นอีกมากมาย 

 โปรแกรมอาฟเตอร์เอฟเฟกต์ (After Effect) เป็นโปรแกรมเหมาะสมอย่างมากในการทำ

ภาพกราฟิกเคลื่อนไหว งานวิดีโอ งานภาพยนตร์ สามารถนำเสนอผลงานออกไปในหลากหลาย    

รูปแบบ ดังที่อิศเรศ ภาชนะกาญจน์ (2559, น.2-4) อธิบายไว้ สรุปได้ดังนี้ 

 1) งานด้านรายการโทรทัศน์ (Television) งานรายการโทรทัศน์ต่างๆ ได้แก่ 

รายการข่าว รายการบันเทิง สารคดี อาศัยภาพเคลื่อนไหวเพื่อให้รายการมีความน่าสนใจมากขึ้น 

เช่น การผลิตไตเติ้ลเปิดและปิดรายการ หรือ กราฟิกเคลื่อนไหวใช้แสดงข้อมูลต่างๆ เป็นต้น 

 2) งานด้านภาพยนตร์ ละคร มิวสิกวิดีโอ (Movie, Series and Music Video) 

สามารถใช้เครื่องมือหรือชุดคำสั่งต่างๆ ในโปรแกรมสร้างความแตกต่าง และสร้างลักษณะพิเศษ

ต่างๆ ให้กับภาพยนตร์ ละคร มิวสิกวิดีโอ ทำให้มีความน่าสนใจหรือสมจริงมากยิ่งขึ้น 

 3) งานด้านการ์ตูน (Animation) เป็นโปรแกรมมีความสามารถในการสร้างการ์ตูน

สองมิติ และมีความสามารถในการสร้างภาพกราฟิกเคลื่อนไหว (Motion Graphic) ซึ่งสามารถ

ตกแต่งลักษณะพิเศษ (Special Effects) และใส่ระบบเสียงแบบพิเศษ (Sound Effects) เพื่อให้

งานมีความน่าสนใจได้อีกด้วย 

 4)  งานด้านสื่อมัลติมีเดีย (Multimedia) และการนำเสนองาน (Presentation) 

โปรแกรมมีความสามารถในการทำงานสื่อมัลติมีเดีย เว็บไซต์ เมนูอินเตอร์เฟส รวมถึงงานนำเสนอ

สินค้า เปิดตัวสินค้า งานเฉลิมฉลอง และงานอีเวนต์ต่างๆ เพื่อให้งานมีความตื่นตาน่าสนใจขึ้น 

 กล่าวโดยสรุปโปรแกรมอาฟเตอร์เอฟเฟกต์มีความสามารถในการทำงานที่หลากหลาย 

สามารถสร้างงานวิดีโอได้หลายรูปแบบ สามารถทำงานร่วมกับโปรแกรมต่างๆ ได้มากมาย อาทิ 

โปรแกรมโฟโต้ชอบ (Photoshop) โปรแกรมอิลัสเตเตอร ์ (lllustrator) โปรแกรมพรีเมียร์โปร 

(Premiere Pro) และโปรแกรมอื่นๆ อีกมากมาย ในการทำงานสามารถตกแต่งและดูผลงานที่สร้าง

ได้ทันที (Real-time) โดยไม่ต้องทำการเรนเดอร์ก่อน การทำงานรองรับไฟล์หลายประเภททั้งไฟล์

เสียง ไฟล์ภาพนิ่งและไฟล์ภาพเคลื่อนไหวทั้งสองมิติและสามมิต ิ ทำให้การทำงานด้วยโปรแกรมนี้มี

ความยืดหยุ่นและสะดวกต่อการใช้งานมาก ด้วยคุณสมบัติที่โดดเด่นจึงทำให้โปรแกรมนี้เป็นที่นิยม

ใช้ในการสร้างภาพเคลื่อนไหว 

 2. องค์ประกอบสำคัญในการทำงานด้วยโปรแกรมอาฟเตอร์เอฟเฟกต์ 

  สำหรับโปรแกรมอาฟเตอร์เอฟเฟกต์มีองค์ประกอบสำคัญในการทำงานดังที่ จุฑามาศ  

จิวะสังข์ (2558, น.8) กล่าวถึง องค์ประกอบสำคัญในการทำงานไว้ สรุปได้ดังนี้ 
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  2.1 โปรเจ็กต์ (Project) เมื่อเปิดโปรแกรมแล้วจะต้องสร้างโปรเจ็กต์เพื่อจัดเก็บชิ้นงาน

ทั้งหมด โดยในโปรเจ็กต์สามารถเก็บคลิปที่นำเข้า (Import) เข้ามา ในหนึ่งโปรเจ็กต์สามารถทำงาน

ได้หลายคอมโพซิชัน ซึ่งเป็นองค์ประกอบย่อยที่มีความสำคัญของโปรเจ็กต์ 

  2.2 คอมโพซิชัน (Composition) เป็นส่วนที่ใช้เป็นพื้นที่การทำงาน เป็นส่วนที่สำคัญ

ที่ใช้ในการสร้างภาพเคลื่อนไหว การเพิ่มเติมลักษณะพิเศษให้กับผลงาน คอมโพซิชันจะรองรับการ

ทำงานกับคลิปที่นำเข้ามาในโปรแกรม สามารถจัดรูปแบบการตกแต่งลักษณะพิเศษ คีย์เฟรม ปรับสี 

ซ้อนฉาก หรือกระบวนการสร้างงานอื่นๆ อีกมากมาย 

  2.3 คลิป (Clip)  หมายถึง  ไฟล์วิดีโอ ไฟล์ภาพ และไฟล์เสียงต่างๆ  ที่นำ เข้ามาใช้ใน   

โปรเจ็กต์โดยแต่ละไฟล์จะเรียกว่าคลิป 

  

 ภาพที่ 4.7 แสดงความสัมพันธ์ของโปรเจ็กต์ คอมโพซิชัน และคลิป 

ที่มา: จุฑามาศ  จิวะสังข์ (2558, น.8) 

  สำหรับการทำงานในโปรแกรมอาฟเตอร์เอฟเฟกต์ มีขั้นตอนในการสร้างภาพเคลื่อนไหว

ซึ่งเป็นขั้นตอนหลัก จุฑามาศ จิวะสังข์ (2558: น.21) กล่าวไว้ดังนี้ 

  1) นำเข้าคลิปเข้ามาทำงาน 

  2) สร้างคอมโพซิชันสำหรับทำงาน 

  3) สร้างการเคลื่อนไหวและเพิ่มเติมลักษณะพิเศษ (Effect)  

  4) การแสดงผลภาพเคลื่อนไหว (Preview) 

  5) การนำเสนอหรือการเรนเดอร์ผลงานภาพเคลื่อนไหว 

  ในการทำงานนั้นไม่ได้มีกำหนดเป็นขั้นตอนที่ตายตัว ทั้งนี้ขึ้นกับความต้องการในการ

สร้างผลงานซึ่งเป็นตัวกำหนดรูปแบบหรือวิธีการทำงานของผู้ออกแบบ  
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 3. พื้นที่การทำงานของโปรแกรมอาฟเตอร์เอฟเฟกต์ 

  การศึกษาส่วนประกอบของพื้นที่การทำงาน คุณสมบัติของชุดเครื่องมือ และชุดคำสั่ง

ต่างๆ ในโปรแกรมอาฟเตอร์เอฟเฟกต์เป็นส่วนสำคัญที่ทำให้ผู้ออกแบบเข้าใจหลักการในการทำงาน

ส่งผลให้การทำงานได้ผลผลิตที่มีประสิทธิภาพ 

  

ภาพที่ 4.8 พื้นที่การทำงานของโปรแกรมอาฟเตอร์เอฟเฟกต์ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ก) 

 3.1 เมนคูำสั่ง (Menu Bar) เปน็สว่นที่ประกอบไปดว้ยชดุคำสั่งที่ใชจ้ดัการกบัไฟลง์าน 

ซึ่งจะแบ่งเป็นหมวดหมู่ ดังนี้  

  1) เมนูไฟล์ (File) เป็นเมนูที่รวมชุดคำสั่งที่เกี่ยวกับการจัดการไฟล์ทั้งหมด ได้แก่ 

การสร้างโปรเจ็กต์ใหม่ การเปิดโปรเจ็กต์ขึ้นมาแก้ไข การบันทึกไฟล์โปรเจ็กต ์ การนำเข้าไฟล์หรือ

คลิปต่างๆ หรือการส่งออกไฟล์ เป็นต้น 

  2) เมนอูดีธิ (Edit) เป็ นเมนทูี่รวมชดุคำสั่งที่เกี่ยวกบัการแกไ้ขงาน ไดแ้ก่  การคดัลอก 

(Copy) การตัด (Cut) การวาง (Patse) การปรับแต่งค่าเบื้องต้นของโปรแกรม การย้อนกลับ  

(Undo) เป็นต้น 
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  3) เมนูคอมโพซิชัน (Composition) เป็นเมนูที่รวมชุดคำสั่งที่เกี่ยวกับการจัดการ

คอมโพซิชัน ได้แก่ การเปิดคอมโพซิชันใหม่ การเรนเดอร์ไฟล์ผลงาน การแสดงผลในรูปแบบต่างๆ 

เป็นต้น 

  4) เมนูเลเยอร์ (Layer) เป็นเมนูที่รวมชุดคำสั่งที่เกี่ยวกับการจัดการกับเลเยอร์ของ

งาน ได้แก่ การสร้างเลเยอร์ใหม่ การรวมเลเยอร์ การแปลงเลเยอร์ รวมถึงการจัดการรายละเอียด

ของเลเยอร์ เป็นต้น 

  5) เมนูเอฟเฟกซ์ (Effect)  เป็นเมนูที่รวมชุดคำสั่งที่เกี่ยวกับการเพิ่มเติมลักษณะ

พิเศษต่างๆ การดัดแปลงภาพ การใส่ลักษณะพิเศษให้กับเสียง 

  6) เมนูแอนิเมชัน (Animation)  เป็นเมนูที่รวมชุดคำสั่งที่เกี่ยวกับการควบคุมคีย์

เฟรม ได้แก่ การสร้างการเคลื่อนไหวให้ตัวอักษร การซ่อนหรือแสดงภาพที่ต้องการ เป็นต้น 

  7) เมนูวิว (View) เป็นเมนูที่รวมชุดคำสั่งที่เกี่ยวกับการปรับเปลี่ยนมุมมองของ

พื้นที่การทำงาน ได้แก่ การขยายและการย่อมุมมองการทำงาน การควบคุมการทำงานของเส้นกริด

และเส้นไกด์ การควบคุมการแสดงผลแบบสามมิติ เป็นต้น 

  8) เมนูวินโดว์ (Window)  ใช้เปิดและปิดพาเนลและกล่องเครื่องมือต่างๆ ใน

โปรแกรม 

  9) เมนูเฮลฟ์ (Help) เป็นส่วนที่แสดงความช่วยเหลือเกี่ยวกับโปรแกรม 

 3.2 แถบเครื่องมือ (Tool Bar) เป็นส่วนที่รวบรวมเครื่องมือที่ใช้ในการทำงาน ซึ่งจะ

แบ่งออกเป็น 6 กลุ่มหลัก ได้แก่ 

  1) กลุ่มการเลือกชิ้นงานและควบคุมมุมมอง ได้แก่ 

   -    เครื่องมือซีเล็คชัน (Selection Tool) ใช้คลิกเลือกชิ้นงานที่ต้องการ

ทำงาน หรือเคลื่อนย้ายตำแหน่ง  

   -    เครื่องมือแฮนด์ (Hand Tool) ใช้ในการเลื่อนมุมมองการทำงาน 

   -    เครื่องมือซูม (Zoom Tool) ใช้ในการย่อหรือมุมมองการทำงาน 

  2) กลุ่มหมุนชิ้นงานและมุมกล้อง ได้แก ่

   -    เครื่องมือโรเทชัน (Rotation Tool) ใช้ในการหมุนชิ้นงานในพื้นที ่

การทำงานตามทิศทางองศาต่างๆ  

   -    เครื่องมือยูนิไฟด์ คาเมรา (Unified Camera Tool) ใช้ในการหมุน

มุมกล้อง สามารถหมุนในแกน X (แนวนอน) แกน Y (แนวตั้ง) แกน Z (แนวลึก) ได้ ภาพจะออกมา

จะมีลักษณะเป็นสามมิติ จะต่างจากเครื่องมือโรเทชันที่หมุนชิ้นงานในระนาบของพื้นที่การทำงาน

เท่านั้น 
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   -    เครื่องมือบีไฮด์ แพน (Behind Pan Tool) ใช้ในการย้ายตำแหน่ง

จุดศูนย์กลางในการหมุนชิ้นงาน (Anchor Point) ซึ่งปกติจะปรากฏอยู่ตรงกลางของชิ้นงาน 

  3) กลุ่มการวาดชิ้นงานและสร้างตัวอักษร ได้แก่ 

   -    เครื่องมือเรคแทนเกิล (Rectangle Tool) เป็นเครื่องมือที ่ใช้ในการ

วาดรูปร่างเรขาคณิต ซึ่งหากคลิกเครื่องมือค้างไว้จะมีเครื่องมือในชุดนี้ปรากฏขึ้นมาอีก 5 เครื่องมือ 

ได้แก่ เครื่องมือในการวาดรูปสี่เหลี่ยม เครื่องมือในการวาดรูปสี่เหลี่ยมมุมโค้ง เครื่องมือในการวาด

รูปวงรี เครื่องมือในการวาดรูปหลายเหลี่ยม และ เครื่องมือในการวาดรูปดาว 

   -    เครื่องมือเพ็น (Pen Tool) ใช้ในการวาดเส้นเส้นพาธ (Path) ทำให้

วาดรูปร่างอิสระได้ตามต้องการ 

   -    เครื่องมือไทป์ (Type Tool) ใช้ในการพิมพ์ตัวอักษรและข้อความ 

  4) กลุ่มการตกแต่งแก้ไขภาพหรือชิ้นงาน ได้แก่  

   -    เครื่องมือบรัช (Brush Tool) ใช้ในการระบายสีชิ้นงาน 

   -    เครื่องมือโคลนสแตมป์ (Clone Stamp Tool) ใช้ในการคัดลอก

ส่วนที่ต้องการ โดยเลือกจุดอ้างอิงในการคัดลอก จากนั้นระบายทับในส่วนที่ต้องการแก้ไข 

   -    เครื่องมืออีลาส (Erase Tool) ใช้ในการลบส่วนที่ไม่ต้องการ 

  5) กลุ่มการเลือกพื้นที่ มีเครื่องมือ 1 เครื่องมือ ได้แก ่

   -    เครื่องมือโรโท บรัช (Roto Brush Tool) ใช้ลบฉากพื้นหลังออก 

โดยการแดรกเมาส์ล้อมรอบชิ้นงานที่ต้องการ ส่วนที่ไม่ได้เลือกจะถูกลบออก 

  6) กลุ่มการสร้างการเคลื่อนไหว มีเครื่องมือ 1 เครื่องมือ ได้แก ่

   -    เครื่องมือพับเพ็ทพิน (Puppet Pin Tool) ใช้สร้างจุดข้อต่อเพื่อใช้

ในการขยับชิ้นงาน และสามารถสร้างการเคลื่อนไหวได้อย่างอิสระ 

 3.3 พาเนลโปรเจ็กต์ (Project) เป็นพื้นที่สำหรับจัดเก็บไฟล์และคลิปต่างๆ ได้แก่ 

ไฟล์วิดีโอ ไฟล์เพลง ไฟล์ภาพ เป็นต้น ไฟล์เหล่านี้เมื่อนำเข้ามาทำงานจะเรียกว่าคลิป ซึ่งพาเนล

โปรเจ็กต์มีส่วนประกอบ 3 ส่วน ดังนี้ 
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ภาพที่ 4.9 ส่วนประกอบของพาเนลโปรเจ็กต์ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ข) 

  1)  ส่วนที่ 1  แสดงรายละเอียดของคลิปหรือไฟล์ที่นำเข้ามา ได้แก่ ชื่อไฟล์ ขนาด 

ไฟล์์ ความยาวของคลิป จำนวนเฟรมต่อวินาที เป็นต้น 

  2)  ส่วนที่ 2  เป็นส่วนที่รวบรวมคลิปหรือไฟล์ทุกประเภท 

  3)  ส่วนที่ 3  เป็นส่วนที่รวบรวมไอคอนชุดคำสั่งสำคัญที่ใช้ควบคุมการทำงานของ

พาเนลโปรเจค ได้แก่   

   -     Create a new Folder คลิกเมื่อต้องการสร้างโฟลเดอร์ไว้รวบรวม

คลิปหรือไฟล์ให้เป็นหมวดหมู่ 

   -     Create a new Composition คลกิเพื่อสรา้งคอมโพซชินัเพิ่มขึ้นมาใหม ่

   -     Delete selected project items คลิกเลือกเมื่อต้องการลบคลิปหรือ

ไฟล์ต่างๆ ในพาเนลนี้ 

 3.4 พาเนลคอมโพซิชัน (Composition) เป็นพื้นที่สำหรับทำงาน การตกแต่งชิ้นงาน 

การเพิ่มลักษณะพิเศษและการแสดงผลลัพธ์ในการทำงาน ซึ่งมีการทำงานควบคู่กับการปรับค่าใน

พาเนลไทม์ไลน์ (Timeline) มีรายละเอียดสำคัญของพาเนล ดังนี้ 
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ภาพที่ 4.10 รายละเอียดสำคัญของพาเนลคอมโพซิชัน 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ค) 

  1)   Magnification เป็นส่วนที่สามารถเลือกขนาดของมุมมอง

ของพื้นที่การทำงาน โดยคลิกเลือกขนาดที่ต้องการ ได้แก่ 100% 50% เป็นต้น 

  2)   Grid and Guide เป็นส่วนที่สามารถเลือกเพื่อแสดงเส้นกริด เส้นไกด์ แถบ

ไม้บรรทัด เส้นกรอบพื้นที่ไตเติล 

  3)    Toggle Mask and Shape Path  เป็นส่วนที่สามารถเลือกเพื่อแสดงจุด

สำหรับดัดเส้นพาธของมาร์คหรือชิ้นงานที่เป็นรูปร่างเพื่อให้ง่ายต่อการแก้ไข 

  4)   Current Time เป็นส่วนที่สามารถกำหนดช่วงเวลาที่แน่นอนตามที่

ต้องการ ณ ช่วงเวลานั้นบนไทม์ไลน์ 

  5)   Take/Show Snap  เป็นส่วนที่สามารถเลือกเพื่อเก็บภาพที่ต้องการ 

เพื่อใช้ในการบันทึกภาพเปรียบเทียบการแสดงผล 

  6)   Resolution/Down Sample เป็นส่วนที่สามารถเลือกเพื่อลด

คุณภาพความละเอียดของตัวอย่างการแสดงผล เพื่อความรวดเร็วในการประมวลผล 

  7)   Transparency Grid เป็นส่วนที่สามารถเลือกพื้นฉากหลังเป็นแบบ

โปร่งใสเพื่อให้เห็นรายละเอียดชัดเจนขึ้น 

 3.5 พาเนลไทม์ไลน์ (Timeline) เป็นส่วนที่ใช้ในการทำงาน แก้ไข ปรับแต่งชิ้นงาน 

หรือไฟล์คลิปต่างๆ โดยทำงานควบคู่กับพาเนลคอมโพซิชันซึ่งเป็นส่วนของการแสดงผล ช่วงเวลาใน
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ไทม์ไลน์ ถูกกำหนดเป็น ชั่วโมง : นาที : วินาที : เฟรม (0:00:00:00) และชิ้นงานแต่ละชั้นจะทำงาน

ในลักษณะเป็นเลเยอร์โดยมีรายละเอียดสำคัญของพาเนล ดังนี้ 

  

ภาพที่ 4.11 รายละเอียดสำคัญของพาเนลไทม์ไลน์ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฅ) 

  1)  Current Time เปน็สว่นที่บอกพกิดัเวลา โดยบอกเปน็ ชั่วโมง : นาท ี : วนิาท ี : 

เฟรม (0:00:00:00) สามารถพิมพ์กำหนดช่วงเวลาตามที่กำหนดได้ 

  2)  A/V Features เป็นส่วนที่ใช้เลือกการแสดงผลของชิ้นงาน คลิปภาพและเสียง

ที่อยู่ในเลเยอร์นั้นๆ  

  3) Label  คลิกเพื่อเลือกสีให้กับแถบของเลเยอร์ เพื่อเป็นการกำหนดกลุ่มของ

แต่ละส่วนของเลเยอร์ ป้องกันความสับสนกรณีมีเลเยอร์จำนวนมาก 

  4) Switches เป็นส่วนที่เลือกหรือกำหนดคำสั่งต่างๆ ให้กับชิ้นงานบนไทม์ไลน์  

  5) Mode/Track Matte/Parent  เป็นส่วนในการเลือกปรับแต่งการทำงานให้กับ

ชิ้นงานระหว่างเลเยอร์ 

  6)  Time Navigator เป็นส่วนที่ใช้เลื่อนหาช่วงเวลาบนไทม์ไลน์ เพื่อสะดวกใน

การทำงานมากขึ้น 

  7)  Time Ruler เป็นแถบที่บอกช่วงเวลา เพื่อให้รู้ช่วงเวลา 

  8) Work Area ใช้กำหนดช่วงเวลาเริ่มและจบในการทำงานบนไทม์ไลน์ 

  9) Current Time Indication เส้นแสดงเวลา ณ เวลาปัจจุบันที่ทำงานอยู่ใช้เมื่อ

ต้องการปรับแต่งชิ้นงาน 

  10) Zoom In/Zoom Out ใช้ในการย่อและขยายมุมมองของเวลาบนไทม์ไลน ์

 3.6 พาเนลอินโฟ (Info) เป็นส่วนที่แสดงรายละเอียดเกี่ยวกับค่าสีและค่าของ

ตำแหน่งของเครื่องมือซีเล็คชันขณะที่ทำงานบนพาเนลคอมโพซิชัน ซึ่งแสดงค่าเป็นแกน X (แนว

นอน) และแกน Y (แนวตั้ง) 
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ภาพที่ 4.12 พาเนลอินโฟ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฆ) 

 3.7 พาเนลออดิโอ (Audio) เป็นส่วนที่ใช้แสดงและใช้ควบคุมการทำงานของเสียง 

สามารถใช้ได้เมื่อมีการทำงานของไฟล์เสียง 

  

ภาพที่ 4.13 พาเนลออดิโอ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ง) 

 3.8 พาเนลพรีวิล (Preview) เป็นส่วนที่ใช้ควบคุมการเล่นและการย้อนกลับของการ

แสดงผล รวมทั้งตั้งค่าการทดสอบและแสดงผลชิ้นงานหลังปรับแต่งลักษณะพิเศษ 
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ภาพที่ 4.14 พาเนลพรีวิล 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560จ) 

   พาเนลพรีวิวใช้สำหรับควบคุมการแสดงผลในไทม์ไลน์ เพื่อตรวจสอบผลงานสุดท้าย
ก่อนการเรนเดอร์ได้ โดยมีเครื่องมือควบคุมดังนี้ 

   -     เลื่อนมายังเฟรมแรกของผลงาน 

   -    เลื่อนมายังเฟรมก่อนหน้าของตำแหน่งขณะที่เครื่องมือกำหนดเวลาปัจจุบัน 

(Current Time Indicator) ชี้อยู่ 
   -   แสดงผลงาน 

   -   เลื่อนมายังเฟรมต่อมาของตำแหน่งขณะที่เครื่องมือกำหนดเวลาปัจจุบัน 

(Current Time Indicator) ชี้อยู่ 

   -   เลื่อนมายังเฟรมสุดท้ายของผลงาน 

   -   เลือกรูปแบบการแสดงผล   เล่นวนซ้ำ และ   เล่นรอบเดียว 
   -   เลือกเพื่อแสดงเสียงหรือไม่แสดงเสียง 
 3.9 พาเนลเอฟเฟกต์ แอนด์ พรีเซ็ต (Effects & Presets) เป็นส่วนที่ใช้เก็บรวบรวม

ลักษณะพิเศษ (Effect) ที่ทำให้ชิ้นงานหรือไฟล์งานมีลักษณะพิเศษแปลกตากว่าปกติ การใช้งาน

ทำได้โดยเลือกรูปแบบลักษณะพิเศษที่ต้องการจากนั้นแดรกเมาส์ลากลงในพื้นที่การทำงาน 
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ภาพที่ 4.15 พาเนลเอฟเฟกต์ แอนด์ พรีเซ็ต 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฉ) 

 4. การทำงานเบื้องต้นของโปรแกรมอาฟเตอร์เอฟเฟกต ์

  การทำงานเบื้องต้นของโปรแกรมนี้เกี ่ยวข้องกับคำสั่งในการจัดการไฟล์งาน การ

สร้างไฟล์งานขึ้นใหม่ การบันทึกไฟล์ผลงาน ซึ่งในโปรแกรมนี้จะเรียกไฟล์งานว่าโปรเจ็กต์ 

(Project) 

  4.1 การสร้างโปรเจ็กต์งานใหม่ สามารถทำได้โดยมีขั้นตอนดังนี้ 

   1)  คลิกเลือกเมนู File > New > New Project จะปรากฏโปรเจ็กต์งานใหม่เพิ่ม

ขึ้นมา  

   2) สร้างพื ้นที ่การทำงานโดยคลิกเลือกเมนู Composit ion > New 

Composition.. หรือคลิกไอคอน   Create a New Composition ที่พาเนลโปรเจ็กต์  

   3) กำหนดค่าคุณสมบัติของพื้นที่การทำงานได้ที่หน้าต่าง Composition Settings 

  4.2 การกำหนดค่าคุณสมบัติคอมโพซิชัน ในการระบุค่าคุณสมบัติทางวิดีโอในหน้าต่าง 

Composition Settings มีรายละเอียดสำคัญ ดังนี้ 
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ภาพที่ 4.16 รายละเอียดการตั้งค่าของหน้าต่าง Composition Settings 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ช) 

     1) Composition Name ใช้ในการตั้งชื่อพื้นที่การทำงานหรือคลิปวิดีโอที่สร้าง

ขึ้น 

     2) Presets เป็นส่วนที่ใช้กำหนดค่าพื้นที่การทำงานทางวิดีโอที่โปรแกรม

เตรียมไว้ให้สำหรับการนำวิดีโอไปใช้งานกับอุปกรณ์และจุดประสงค์ที่แตกต่างกัน ดังภาพที่ 4.17 
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ภาพที่ 4.17 รายละเอียดของค่า Presets 
ที่มา: จุฑามาศ  จิวะสังข์ (2558, น.45) 

     3) Width และ Height เป็นส่วนที่ใช้กำหนดขนาดความกว้างและความสูง

ของเฟรมวิดีโอ มีหน่วยเป็น Pixel 

     4)  Lock Aspect Ratio คลิกเลือกเพื่อเป็นการควบคุมอัตราส่วนขนาดความ

กว้างและความสูงของงานวิดีโอที่สร้างไม่ให้ผิดเพี้ยน 

     5)  Pixel Aspect Ratio ตั้งค่าอัตราส่วนของขนาดเฟรมระหว่างความกว้าง 

และความสูงของงานวิดีโอ โดยมีรายละเอียดดังนี้ 

      -  Square Pixels เป็นอัตราส่วนสำหรับไฟล์ที่ใช้งานกับคอมพิวเตอร์ หรือ

อุปกรณ์ดิจิทัล 

      - D1/DV เป็นอัตราส่วนสำหรับไฟล์ที่ใช้งานกับกล้อง DV มีทั้งอัตราส่วน

ปกติที่ใช้งานกับระบบ PAL และ NTSC และอัตราส่วนแบบ Widescreen 

      -  HDV/DVCPRO เป็นอัตราส่วนสำหรับไฟล์ที่ใช้งานกับอุปกรณ์ที่รองรับ

งานวิดีโอระดับ HD เช่น HDTV เป็นต้น 

      -  Anamorphic เปน็อตัราสว่นสำหรบังานพเิศษที่ตอ้งการมมุมองแนวกวา้ง 
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     6)  Frame Rate เป็นส่วนที่ใช้กำหนดจำนวนเฟรมหรืออัตราความถี่ในการ

แสดงผลภาพเคลื่อนไหว โดยคิดเป็นจำนวนเฟรมต่อวินาที (Frames per second) ซึ่งงานโทรทัศน์

ในประเทศไทยจะแสดงผลภาพจำนวน 25 เฟรมต่อ 1 วินาที 

     7) Resolution เป็นส่วนที่ใช้กำหนดขนาดความละเอียดของเฟรมโดยอ้างอิง

กับความกว้างและความสูงมีหน่วยเป็นพิกเซล (Pixel) 

     8)  Start Timecode เป็นส่วนที่ใช้กำหนดจุดเริ่มต้นของการแสดงวิดีโอ โดย

ให้ระบุเฟรมที่ต้องการเริ่มต้น ซึ่งไม่ควรเกินค่า Duration หากเป็นการสร้างคอมโพซิชันทั่วไปไม่

นิยมกำหนดค่านี้ นอกจากต้องการกำหนดค่าอย่างเจาะจงในการทำงาน 

     9) Duration เป็นส่วนที่ใช้กำหนดค่าของระยะเวลาในการแสดงผลชิ้นงาน

ทั้งหมด ตวัเลขที่ปรากฏในคา่ Duration ถกูกำหนดเปน็ ชั่วโมง : นาท ี: วนิาท ี: เฟรม (0:00:00:00) 

     10) Background Color สำหรับกำหนดสีพื้นหลังให้กับคอมโพซิชัน ซึ่ง

สามารถปรับแต่งได้ในภายหลัง 

  4.3 การนำเข้าไฟล์ (Import) ในการสร้างภาพเคลื่อนไหวนั้นอาจต้องมีการนำไฟล์

วิดีโอหรือไฟล์ภาพกราฟิกเข้ามาเพื่อทำให้เกิดการเคลื่อนไหวบนพื้นที่การทำงาน ซึ่งโปรแกรม

สามารถรองรับไฟล์ได้หลากหลายระบบ มีรายละเอียดดังนี้ 

ตารางที่ 4.1 ไฟล์ที่โปรแกรมรองรับ 

ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ก) 

ไฟล์วิดีโอ ข้อมูลภาพเคลื่อนไหวที่แสดงต่อเนื่องกัน รองรับไฟล์ได้หลากหลายจาก
อุปกรณ์ที่ใช้ในการถ่ายทำวิดีโอ

ไฟล์ภาพนิ่ง ข้อมูลภาพนิ่ง ภาพกราฟิกแบบเวกเตอร์ ภาพกราฟิกแบบบิตแมท หรือ
ภาพสามมิติ ซึ่งสามารถนำมาเป็นชิ้นงานในการสร้างการเคลื่อนไหวด้วยวิธี
สร้างคีย์เฟรม หรือใช้วิธีนำเข้า (Import) ภาพเข้ามาเป็นซีเควนซ์แบบ   
ต่อเนื่อง

ไฟล์เสียง ข้อมูลเสียงที่ติดมากับไฟล์วิดีโอ หรือเฉพาะข้อมูลเสียง ซึ่งไม่มี          
ภาพประกอบ

ไฟล์โปรเจ็กต์ ไฟล์งานที่สร้างจากโปรแกรมตัดต่ออื่นๆ หรือไฟล์งานโปรเจ็กต์อื่นๆ    
จากโปรแกรมอาฟเตอร์เอฟเฟกต์เอง
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  การนำไฟล์ต่างๆ เข้ามาทำงานในโปรเจ็กต์ เรียกว่า การนำเข้า (Import) ซึ่งวิธี

การนำเข้าไฟล์ทำได้โดย มีขั้นตอนดังนี้ 

  1) คลกิเลอืกเมนคูำสั่ง File > Import > จากนั้นเลอืกรปูแบบการนำเขา้ไฟล ์หรือ

คลิกขวาที่เมาส์ในพาเนลโปรเจกต์แล้วเลือก Import > จากนั้นเลือกรูปแบบการนำเข้าไฟล์ 

  2) เลือกไฟล์ที่ต้องการเข้ามาทำงานในโปรเจ็กต ์

  3) คลิกปุ่ม Open 

  4) ไฟล์จะถูกเรียกเข้ามาทำงานในโปรเจ็กต์นั้น 

 จากวิธีการดังกล่าวพบว่ามีตัวเลือกรูปแบบของการนำเข้าหลายรูปแบบ โดยแต่ละ

รูปแบบใช้เรียกไฟล์เข้ามาทำงานตามวัตถุประสงค์ที่ต่างกัน ดังนี้  

ตารางที่ 4.2 รูปแบบการนำเข้าไฟล์ (Import) 

ที่มา: จุฑามาศ จิวะสังข์ (2558, น.31-32) 

File เป็นการนำเข้าไฟล์แบบปกติ

Multiple Flies เป็นการนำเข้าไฟล์ที่ต้องการทำงานได้หลายไฟล์ และหลัง
จากเลือกไฟล์ใดไฟล์หนึ่งแล้ว โปรแกรมจะแสดงหน้าต่าง 
Import ให้เลือกไฟล์ที่ต้องการได้ไม่จำกัดจำนวนครั้ง  
จนกระทั่งเลือกไฟล์ครบตามที่ต้องการจึงคลิกปุ่ม Done

Adobe Premiere Pro Project เป็นการนำเข้าโปรเจ็กต์ที่สร้างขึ้นจากโปรแกรมพรีเมียร์โปร 
(Premiere Pro) เข้ามาทำงานในโปรแกรมอาฟเตอร์
เอฟเฟกต์

Pro Import After Effects เป็นการนำเข้าโปรเจ็กต์ที่สร้างขึ้นจากโปรแกรมตัดต่ออื่นๆ 
อาทิ โปรแกรมไฟนอลคัทโปร (Final Cut Pro)  
โปรแกรมโซนี่เวกัส (Sony Vegas) เป็นต้น เข้ามาทำงานใน
โปรแกรมอาฟเตอร์เอฟเฟกต์

Vanishing Point เป็นการนำเข้าไฟล์ภาพนิ่งที่ถูกตกแต่งด้วยคำสั่ง Vanishing 

Point จากโปรแกรมโฟโต้ชอป (Photoshop) เพื่อสร้างให้

ภาพนิ่งสองมิติกลายเป็นสามมิติ ด้วยการกำหนดระนาบ

สมมติให้กับภาพ ซึ่งไฟล์ตระกูลนี้จะอยู่ในสกุล .vpe
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ตารางที่ 4.2 (ต่อ) รูปแบบการนำเข้าไฟล์ (Import) 

ที่มา: จุฑามาศ จิวะสังข์ (2558, น.31-32) 

  4.3.1 วิธีนำเข้าไฟล์ทั้งโฟลเดอร์ การนำเข้าไฟล์ทั้งโฟลเดอร์เหมาะสำหรับงานที่ได้

จัดเก็บไว้อย่างเป็นระบบแล้วในโฟลเดอร์ใดโฟลเดอร์หนึ่ง และเมื่อใช้คำสั่งนำเข้าไฟล์ที่ถูกนำเข้ามา

จะถูกจัดเก็บเป็นโฟลเดอร์ในพาเนลโปรเจ็กต์โดยอัตโนมัติ 

  4.3.2 วิธีนำเข้าไฟล์ภาพนิ่ง ไฟล์ภาพนิ่งที่นำมาจากโปรแกรมอิลัสเตเตอร์ 

(Illustrator) หรือไฟล์จากโปรแกรมโฟโต้ชอป (Photoshop) ทำได้โดยคลิกเลือกเมนู File > 

Import > File จากนั้นจะมีการระบุรูปแบบของการนำเข้า ซึ่งมีให้เลือก 2 รูปแบบ คือ 

   1) การนำเขา้ไฟลเ์ปน็ฟตุเทจ (Footage) เมื่อนำเขา้มาในโปรเจก็ต ์ไฟล์นั้นจะ

เป็นไฟล์ภาพปกติ และสามารถเลือกได้ว่าต้องการให้นำเลเยอร์ในไฟล์เลเยอร์ใดเข้ามา หรือนำเข้า

มาทั้งหมดโดยการรวมเลเยอร์ (Merge) 

Placeholder ในกรณีที่ยังไมแน่ชัดว่าจะใช้คลิปใดมาทำงานบนไทม์ไลน์ 

แต่ต้องการระบุจุดการวางคลิปไว้ก่อน สามารถทำได้โดย

การจองพื้นที่บนไทม์ไลน์โดยสร้างคลิปจำลองขึ้นมาด้วยการ

เลือกคำสั่ง Placeholder เพื่อวางคลิปจำลองแทนไปก่อน

แล้วจึงแทนที่คลิปที่ต้องการในภายหลัง

Solid เป็นการเลือกสร้างคลิปสีพื้นมาทำงานบนไทม์ไลน์ โดย

สามารถกำหนดทั้งขนาด จำนวนเฟรมต่อวินาที (Frame 

Rate)  และความยาวในการแสดงคลิปได้ตามต้องการ
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ภาพที่ 4.18 การนำเข้าไฟล์เป็นฟุตเทจแบบรวมเลเยอร์ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ซ) 

  

ภาพที่ 4.19 การนำเข้าไฟล์เป็นฟุตเทจแบบเลือกเลเยอร์ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฌ) 

   2) การนำเขา้เปน็คอมโพซชินั (Composition) ไฟล์ ภาพที่นำเขา้มาใน    

โปรเจ็กต์จะถูกสร้างเป็นคอมโพซิชันและสามารถทำงานผ่านไทม์ไลน์ได้ทันที 
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ภาพที่ 4.20 การนำเข้าไฟล์เป็นคอมโพซิชัน 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ญ) 

  หากเลือก Merge Layer Styles into Footage ในหัวข้อ Layer Options จะได้

ผลลัพธ์เป็นลักษณะเดียวกัน ต่างกันที่การประมวลผลจะทำได้เร็วกว่า แต่คุณสมบัติของรูปแบบ 

(Style) จากโปรแกรมโฟโต้ชอป จะไม่สามารถปรับแต่งแบบเต็มรูปแบบได้ 

  4.4 การเปิดโปรเจ็กต์ขึ้นมาใช้งาน (Open Project)  เมื่อต้องการเปิดงานเก่าขึ้นมา

ทำต่อ สามารถทำได้โดยคลิกเลือเมนู File > Open Project จะปรากฏหน้าต่าง Open ขึ้น จากนั้น

ทำการเลือกไฟล์โปรเจ็กต์งานที่ต้องการ แล้วคลิกปุ่ม Open เพื่อเปิดไฟล์โปรเจกต์ และสามารถใช้

แป้นพิมพ์ลัดโดยกดแป้น [Command] + [O] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ IMac หรือกดแป้น 

[Ctrl] + [O] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ PC 

  

ภาพที่ 4.21 หน้าต่างคำสั่งเปิดโปรเจกต์ 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฎ) 
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 4.5 การบันทึกไฟล์โปรเจ็กต์ (Save Project) การบันทึกไฟล์ในขณะทำงานเป็นเรื่อง

ที่สำคัญอย่างยิ่งในการป้องกันเหตุอันไม่พึงประสงค์ เช่น คอมพิวเตอร์มีปัญหาไม่สามารถทำงานต่อ

ได้ ไฟฟ้าขัดข้อง ฯลฯ หากผู้ทำงานไม่ทำการบันทึกไฟล์งานไว้อาจทำให้ต้องเริ่มทำงานใหม่ตั้งแต่

แรก ในการบันทึกไฟล์งานนั้นทำได้โดยคลิกเลือกเมนูคำสั่ง File > Save As > Save As... จะ

ปรากฏหน้าต่าง Save As ขึ้น จากนั้นตั้งชื่อไฟลโ์ปรเจกตแ์ละเลอืกตำแหนง่ในการจดัเกบ็ไฟลโ์ปรเจกต ์

แล้วคลิกปุ่ม Save 

   เมื่อทำการบันทึกไฟล์งานครั้งแรกแล้ว ในขณะที่ทำงานต่อไปสามารถบันทึกไฟล์

งานอีกครั้งโดยการคลิกเมนูคำสั่ง File > Save และสามารถใช้แป้นพิมพ์ลัดโดยกดแป้น 

[Command] + [S] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ IMac หรือกดแป้น  [Ctrl] + [S] ที่แป้นพิมพ์

ในเครื่องคอมพิวเตอร์ PC 

  

ภาพที่ 4.22 หน้าต่างคำสั่งบันทึกไฟล์โปรเจกต์ 

ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฏ) 

 4.6 การควบคุมมุมมองการทำงาน การทำงานในหน้าต่างของพาเนลคอมโพซิชันนั้น 

ความเข้าใจเกี่ยวกับคำสั่งและเครื่องมือที่ใช้ในการควบคุมมุมมองการทำงานจะช่วยให้การทำงาน

สะดวกยิ่งขึ้น โดยคำสั่งและเครื่องมือที่เกี่ยวข้องกับการควบคุมมุมมองในการทำงานมีดังนี้ 
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  4.6.1 การย่อและขยายมุมมองการทำงาน (Zoom) ในการย่อและขยายมุมมอง

การทำงานทำเมื่อต้องการเข้าใกล้ภาพหรือชิ้นงาน ซึ่งช่วยในการทำงานสะดวกและถนัดมากขึ้น การ

ย่อและขยายมุมมองการทำงานมีวิธีดังนี้ 

    1)  การขยายมุมมองการทำงาน (Zoom In) มีหลายวิธีดังนี้ 

     -  คลิกเมนูคำสั่ง View > Zoom In มุมมองจะถูกขยายขึ้นทันที  

     - การขยายมุมมองแบบเจาะจงเฉพาะจุดที่ต้องการ สามารถทำได้โดย

คลิกเลือกเครื่องมือซูม (Zoom Tool)   จากนั้นคลิกพื้นที่ในส่วนที่ต้องการขยาย  

     - การใช้แป้นพิมพ์ลัดโดยกดแป้น [Command] + [+] ที่แป้นพิมพ์ใน

เครื่องคอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [+] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ PC 

    2)  การย่อมุมมองการทำงาน (Zoom Out) มีหลายวิธีดังนี้ 

     -  คลิกเมนูคำสั่ง View > Zoom Out มุมมองจะถูกย่อลงทันที  

     - การย่อมุมมองแบบเจาะจงเฉพาะจุดที่ตอ้งการ สามารถทำไดโ้ดยคลกิ

เลอืกเครื่องมอืซมู (Zoom Tool)   จากนั้นคลกิปุ่ม Alt ที่แปน้พมิพค์้างไว้เพื่อให้แว่นขยายเป็ น

เครื่องหมายลบ จากนั้นคลิกเลือกพื้นที่ในส่วนที่ต้องการย่อ  

     - การแป้นพิมพ์ลัดโดยกดแป้น [Command] + [-] ที่แป้นพิมพ์ใน

เครื่องคอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [-] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ PC 

  4.6.2 การเลื่อนมุมมองการทำงาน ในการทำงานสามารถเลื่อนมุมมองพื้นที่การ

ทำงานโดยคลิกเครื่องมือแฮนด์ (Hand Tool)   จากนั้นคลิกเม้าส์ลงบนภาพแล้วแดรกเม้าส์ไปยั ง

จุดที่ต้องการ 

  4.6.3 การแสดงแถบไม้บรรทัด ในการกำหนดหรือวัดระยะสามารถทำได้โดยคลิก

เลือกเมนูคำสั่ง View > Show Rules และเพื่อความรวดเร็วสามารถใช้แป้นพิมพ์ลัดโดยกดแป้น 

[Command] + [R] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [R] ที่แป้นพิมพ์

ในเครื่องคอมพิวเตอร์ PC จะปรากฏแถบไม้บรรทัดขึ้นในพาเนลคอมโพซิชัน 
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ภาพที่ 4.23 การแสดงแถบไม้บรรทัด 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฐ) 

  4.6.4 การแสดงเส้นไกด์ เป็นเส้นที่ใช้ในการวัดระยะ ช่วยอำนวยความสะดวกใน
การวางชิ้นงานตามระยะที่ต้องการ การนำเส้นไกด์ออกมาใช้งานทำได้โดยคลิกเมาส์ที่แถบไม้บรรทัด 
จากนั้นทำการแดรกเมาส์ลากเส้นไกด์ไปยังตำแหน่งที่ต้องการ และเมื่อต้องการยกเลิกเส้นไกด์ทำได้
โดยการคลิกเมนูคำสั่ง View > Show Guides และสามารถใช้แป้นพิมพ์ลัดโดยกดแป้น 
[Command] + [;] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [;] ที่แป้นพิมพ์ใน
เครื่องคอมพิวเตอร์ PC 

  

ภาพที่ 4.24 การแสดงเส้นไกด์ 

ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฑ) 



 159

  4.6.5 การแสดงเส้นกรอบพื้นที่ การแสดงเส้นกรอบพื้นที่เป็นการแสดงพื้นที่ Safe 

Area ซึ่งเป็นส่วนที่กำหนดให้ชิ้นงาน หรือภาพกราฟิกต่างๆ ที่ใส่ไปในงานไม่ให้เกินเส้นกรอบนี้ ไม่

เชน่นั้นอาจตกกรอบของจอภาพได ้ การแสดงเสน้กรอบพื้นที่ทำไดโ้ดยคลกิปุ่ม Choose Grid and 

Guide Option จากนั้นเลือก Title/Action Safe (ดังภาพที่ 4.24) เพื่อแสดงหรือยกเลิกเส้นกรอบนี้ 

  

ภาพที่ 4.25 การแสดงเส้นกรอบพื้นที่ Safe Area 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ฒ) 

 4.7 คำสั่งในการแก้ไขชิ้นงาน คำสั่งพื้นฐานในการแก้ไขชิ้นงาน ช่วยให้การปรับแต่ง 

ชิ้นงานมีความสะดวกรวดเร็วยิ่งขึ้น เช่น คำสั่งในการคัดลอกชิ้นงานในกรณีที่ต้องการชิ้นงานเดิม

หลายชิ้น การแก้ไขข้อผิดพลาดในการทำงานด้วยคำสั่งย้อนกลับ ซึ่งคำสั่งที่เกี่ยวข้องในการแก้ไข  

ชิ้นงานมีดังนี้ 

  4.7.1 คำสั่งในการยอ้นขั้นตอนการทำงาน (Undo / Redo / History) การแกไ้ข

ขั้นตอนการทำงานสามารถใช้คำสั่งในการย้อนขั้นตอน 3 คำสั่งดังนี้ 

    1) การย้อนขั้นตอนกลับไป (Undo) เมื่อเกิดข้อผิดพลาดในการทำงาน และ

ต้องการจะกลับไปขั้นตอนที่เคยทำก่อนหน้านั้น สามารถทำได้โดยคลิกเมนูคำสั่ง Edit > Undo และ

สามารถใช้แป้นพิมพ์ลัดโดยกดแป้น [Command] + [Z] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ IMac 

หรือกดแป้น [Ctrl] + [Z] ที่คีย์บอร์ดในเครื่องคอมพิวเตอร์ PC ขั้นตอนจะถูกย้อนกลับไปในทันที 
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    2) การย้อนขั้นตอนกลับมา (Redo) เมื่อใช้คำสั่งในการย้อนกลับ (Undo) ไป

แล้ว จากนั้นเปลี่ยนใจต้องการย้อนขั้นตอนกลับมาเหมือนเดิม สามารถทำได้โดยคลิกเลือกเมนู Edit 

> Redo และสามารถใช้แป้นพิมพ์ลัดโดยกดแป้น [Command] + [Shift] + [Z] ที่แป้นพิมพ์ใน

เครื่องคอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [Shift] + [Z] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ PC 

ขั้นตอนจะถูกย้อนกลับมาในทันที 

    3) การย้อนกลับหลายขั้นตอน (Hisyory) เมื่อทำงานไปหลายขั้นตอนแล้ว 

ต้องการย้อนกลับไปขั้นตอนต่างๆ สามารถคลิกเลือกคำสั่ง Edit > History คำสั่งนี้ได้เก็บขั้นตอน

การทำงานที่ผ่านมา ซึ่งสามารถเลือกขั้นตอนที่ต้องการย้อนกลับได้เลย 

  

ภาพที่ 4.26 คำสั่งในการย้อนกลับหลายขั้นตอน 
ที่มา: สุธาทิพย์  หอมสุวรรณ (2560ณ) 

  4.7.2 คำสั่งในการคัดลอกชิ้นงาน (Copy) การคัดลอกชิ้นงานเดิมให้มีหลาย    

ชิ้นงานโดยที่มีลักษณะเหมือนกัน สามารถทำได้โดยคลิกเลือกชิ้นงานที่ต้องการคัดลอก จากนั้นคลิก

เลือกเมนู Edit > Copy และสามารถใช้แป้นพิมพ์ลัดโดยกดแป้น [Command] + [C] ที่แป้นพิมพ์

ในเครื่องคอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [C] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ PC ชิ้น

งานจะถูกคัดลอกทันที  

  4.7.3 คำสั่งในการวางชิ้นงาน (Paste) เมื่อใช้คำสั่งในการคัดลอก (Copy) แล้ว 

จะต้องใช้คำสั่งในการวางชิ้นงาน (Paste) เพื่อวางชิ้นงานที่คัดลอกไว้ สามารถทำได้โดยคลิกเมนู 

Edit > Paste และสามารถใช้แป้นพิมพ์ลัดโดยกดแป้น [Command] + [V] ที่แป้นพิมพ์ในเครื่อง
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คอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [V] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ PC ชิ้นงานที่ถูกคัด

ลอกไว้จะเพิ่มขึ้นมาอีกหนึ่งชิ้น 

  4.7.4 คำสั่งในการตัดชิ้นงาน (Cut) เป็นคำสั่งในการย้ายชิ้นงาน โดยชิ้นงานจะ

ถูกตัดหายไปโดยใช้คำสั่งในการตัดชิ้นงาน (Cut) แล้วไปวางไว้ในตำแหน่งใหม่โดยใช้คำสั่งในการวาง

ชิ้นงาน (Paste) สามารถทำได้โดยคลิกเมนู Edit > Cut และสามารถใช้แป้นพิมพ์ลัดโดยกดแป้น 

[Command] + [X] ที่แป้นพิมพ์ในเครื่องคอมพิวเตอร์ IMac หรือกดแป้น [Ctrl] + [X] ที่แป้นพิมพ์

ในเครื่องคอมพิวเตอร์ PC 

  4.7.5 การลบชิ้นงาน เมื่อต้องการลบชิ้นงาน สามารถทำได้โดยการคลิกเลือกชิ้น

งานที่ต้องการลบ จากนั้นกดแป้น Delete ที่แป้นพิมพ์  ชิ้นงานจะถูกลบไปในทันที 

บทสรุป 

 ในปัจจุบันมีโปรแกรมที่ใช้ในการสร้างภาพเคลื่อนไหวหลายโปรแกรมให้เลือกใช้ตามโจทย์

และวัตถุประสงค์ในการออกแบบ โปรแกรมอาฟเตอร์เอฟเฟกต์ (After Effect) เป็นโปรแกรมหนึ่งที่

สามารถสร้างผลงานภาพเคลื่อนไหวในรูปแบบสองมิติและสามมิติ มีคุณสมบัติที่มีการทำงานที่ตอบ

สนองความต้องการของผู้ออกแบบได้หลากหลายและมีประสิทธิภาพมาก ปัจจุบันโปรแกรมนี้มี

บทบาทอย่างมากในงานออกแบบภาพเคลื่อนไหว ใช้ในการผลิตงานหลากหลายสื่อ อาทิ ผลงานที่

ประกอบในรายการโทรทัศน์ต่างๆ ใช้สร้างความแปลกใหม่ให้กับงานภาพยนตร์ ละคร มิวสิกวิดีโอ 

ใช้ในการออกแบบภาพเคลื่อนไหวเพื่อความบันเทิงและให้ความข้อมูลความรู้ งานออกแบบสื่อ

มัลติมีเดีย สื่อออนไลน์ต่างๆ 

 ในการสร้างผลงานภาพเคลื่อนไหวด้วยโปรแกรมอาฟเตอร์เอฟเฟกต์ให้มีผลลัพธ์ออกมา

อย่างมุคุณภาพนั้น ผู้ออกแบบนอกจากจะต้องมีความรู้ในหลักการและกระบวนการในการออกแบบ

ภาพเคลื่อนไหวแล้ว ยังต้องศึกษาและทำความเข้าใจถึงคุณสมบัติการใช้งาน องค์ประกอบสำคัญใน

การทำงาน การทำงานพื้นฐานของโปรแกรม เพื่อให้สามารถนำคุณสมบัติต่างๆ ของโปรแกรมมา

ประยุกต์ใช้ในการออกแบบผลงานภาพเคลื่อนไหวได้อย่างมีประสิทธิภาพและสวยงาม 
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คำถามทบทวน 

คำสั่ง  จงตอบคำถามต่อไปนี้ 

 1.  จงอธิบายคุณสมบัติของโปรแกรมอาฟเตอร์เอฟเฟกต์ (After Effect) 

 2.  โปรแกรมอาฟเตอร์เอฟเฟกต์ (After Effect) เหมาะกับการสร้างงานลักษณะใดบ้าง 

 3. จงอธบิายองคป์ระกอบสำคญัในการทำงานในโปรแกรมอาฟเตอรเ์อฟเฟกต ์(After Effect) 

 4.  จงอธิบายคุณสมบัติการใช้งานพาเนลโปรเจ็กต์ (Project) 

 5.  จงอธิบายคุณสมบัติการใช้งานพาเนลคอมโพซิชัน (Composition) 

 6.  จงอธิบายคุณสมบัติการใช้งานพาเนลไทม์ไลน์ (Timeline) 

 7.  พาเนลใดที่ใช้ควบคุมการเล่นหรือการแสดงผลของผลงาน 

 8.  พาเนลใดที่ใช้แสดงและใช้ควบคุมการทำงานของเสียง 

 9.  จงอธิบายขั้นตอนในการสร้างโปรเจ็กต์งานใหม่ 

 10. จงอธิบายขั้นตอนในการสร้างพื้นที่การทำงาน (Composition) 

 11. การคลิกเลือก Lock Aspect Ratio ในการกำหนดค่าต่างๆ ของพื้นที่การทำงาน 

(Composition) เพื่ออะไร อธิบาย 

 12. จงอธิบายขั้นตอนในการนำเข้า (Import) ไฟล์ฟุตเทจที่เป็นไฟล์ภาพ 

 13. เครื่องมืออะไรที่ใช้ในการเลื่อนมุมมองการทำงาน 

 14. จงอธิบายขั้นตอนในการบันทึกไฟล์โปรเจ็กต์ (Save Project) 

 15. การใช้แป้นพิมพ์ลัดโดยกดแป้น Ctrl + Shift + Z คือคำสั่งอะไร 



 163

เอกสารอ้างอิง 

หนังสือและบทความในหนังสือ 

จง บุญประชา (2548). การสร้างงาน 3 มิติ ด้วยโปรแกรม 3D Studio Max. กรุงเทพฯ: คณะ

เทคโนโลยีอุตสาหกรรม มหาวิทยาลัยราชภัฏสวนสุนันทา. 

จุฑามาศ  จิวะสังข์. (2558). สร้างสรรค์เอฟเฟ็กต์และตกแต่งงานวิดีโอด้วย After Effect CS6+CC 

ฉบับสมบูรณ์. กรุงเทพฯ: รีไวว่า. 

ดนัย ม่วงแก้ว. (2552). Flash Cartoon Animation. กรุงเทพฯ: ไอดีซี อินโฟ ดิสทริบิวเตอร์. 

อิศเรศ  ภาชนะกาญจน.์ (2559). Professional Guide After Effect CC คู่มอืฉบบัสมบรูณ.์ นนทบรุ:ี   

ไอดซีฯี. 

เอกสารอื่นๆ 

กฤษณ์ ปรัชญาทิน. (2558). หมดยุค Flash แล้ว Adobe Flash กำลังจะกลายเป็น Adobe 

Animate สำหรับพัฒนา HTML5 โดยเฉพาะ. สืบค้น 5 พฤษภาคม 2560, จาก 

https://www.beartai.com/news/itnews/70352 

สิทธิชัย ทิพย์สิงห์. (ม.ป.ป.). ความรู้เบื้องต้นเกี่ยวกับ Flash. สืบค้น 5 พฤษภาคม 2560, จาก   

http://www.kroojan.com/flash/content/flash-intro.html 

(2558, 10 มีนาคม). Maya (โปรแกรม Maya ทำอนิเมชั่น สร้างการ์ตูน Animation). สืบค้น 5 

พฤษภาคม 2560, จาก https://software.thaiware.com/5460-Maya-Animation-

Download.html 

สุธาทิพย์  หอมสุวรรณ. (ผู้ถ่ายภาพ). (2560ก). พื้นที่การทำงานของโปรแกรมอาฟเตอร์เอฟเฟกต์ 

(After Effect). [ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัย

ราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ข). ส่วนประกอบของพาเนลโปรเจ็กต์ (Project). [ภาพถ่าย]. 

กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ค). รายละเอียดสำคัญของพาเนลคอมโพซิชัน (Composition). 

[ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จ

เจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ฅ). รายละเอียดสำคัญของพาเนลไทม์ไลน์ (Timeline). [ภาพถ่าย]. 

กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

https://www.beartai.com/news/itnews/70352
http://www.kroojan.com/flash/content/flash-intro.html


 164

________. (ผู้ถ่ายภาพ). (2560ฆ). พาเนลอินโฟ (Info). [ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบ

นิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ง). พาเนลออดิโอ (Audio). [ภาพถ่าย]. กรุงเทพฯ: สาขาวิชา

ออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560จ). พาเนลพรีวิล (Preview). [ภาพถ่าย]. กรุงเทพฯ: สาขาวิชา

ออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ฉ). พาเนลเอฟเฟกต์ แอนด์ พรีเซ็ต (Effects & Presets). 

[ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จ

เจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ช). รายละเอียดการตั้งค่าของหน้าต่าง Composition Settings. 

[ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จ

เจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ช). รายละเอียดการตั้งค่าของหน้าต่าง Composition Settings. 

[ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จ

เจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ซ). การนำเข้าไฟล์เป็นฟุตเทจแบบรวมเลเยอร์ (Merge). 

[ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จ

เจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ฌ). การนำเข้าไฟล์เป็นฟุตเทจแบบเลือกเลเยอร์. [ภาพถ่าย]. 

กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ญ). การนำเข้าไฟล์เป็นคอมโพซิชัน. [ภาพถ่าย]. กรุงเทพฯ: สาขา

วิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ฎ). หน้าต่างคำสั่งเปิดโปรเจกต์ (Open Project). [ภาพถ่าย]. 

กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ฏ). หน้าต่างคำสั่งบันทึกไฟล์โปรเจกต์ (Save As). [ภาพถ่าย]. 

กรุงเทพฯ: สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ฐ). การแสดงแถบไม้บรรทัด. [ภาพถ่าย]. กรุงเทพฯ: สาขาวิชา

ออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ฑ). การแสดงเส้นไกด์. [ภาพถ่าย]. กรุงเทพฯ: สาขาวิชาออกแบบ

นิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 



 165

________. (ผู้ถ่ายภาพ). (2560ฒ). การแสดงเส้นกรอบพื้นที่ Safe Area. [ภาพถ่าย]. กรุงเทพฯ: 

สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

________. (ผู้ถ่ายภาพ). (2560ณ). การย้อนกลับหลายขั้นตอน (Hisyory). [ภาพถ่าย]. กรุงเทพฯ: 

สาขาวิชาออกแบบนิเทศศิลป์ มหาวิทยาลัยราชภัฏบ้านสมเด็จเจ้าพระยา. 

Reference 

Other document(s) 

Adobe. (2016). Animate just about anything. RetrievedMay 10, 2017, from https://

www.adobe.com/sea/products/animate.html 

Autodesk. (2015). Character animation and rigging tools. Retrieved May 10, 2017, 

from https://www.autodesk.com/products/3ds-max/features 

________. (2015). Clump modifier for interactive grooming. Retrieved May 10, 2017, 

from https://www.autodesk.com/products/maya/features 

EB Design. (2015). Flash-the most common animation program for the internet. 

Retrieved May 10, 2017, from https://ebarnette15.wordpress.com/

category/digital-art-3-animation/page/3/ 

Lightwave3d. (2015). Genoma 2 allows you to create expert rigs for character 

animation. Retrieved May 10, 2017, from https://www.lightwave3d.com/

news/article/lightwave-2015-unveiled-new-pricing-announced/ 

Yaron Sass. (2016). Character Animation Frustrations for After Effects users. 

Retrieved May 10, 2017, from https://www.linkedin.com/pulse/character-

animation-frustrations-after-effects-users-yaron-sass/ 



 166


